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This quickstart will help you set up your MS Windows machine to explore the sourcecode of
Bonsai or develop and debug your blender scripts in VSCode. This has the benefit of having
a complete development environment where you can explore the code, make changes,

debug (break-points, watch variable and stack contents, etc. ) and see the results in blender

e Steps 1-6 will get you started with VSCode to develop and debug python scripts in

Blender and explore the Bonsai sourcecode and documentation.

e Steps 7-14 will allow you to interact with GitHub to make changes to the Bonsai project.

We will be using AlmalLinux 9 as our operating system and Visual Studio Code as our

Integrated Development Environment (IDE) and we will create a dedicated user for

Development.

1. Create Development User: Open Windows Settings (typically hitting “Windows” key and
writting “settings” in the search field) and then go to (Accounts » Other users]. Click on

and then add a new user. We will name it falken10vdl

& Settings

vdl
falken10vdi@gmail.com

Find a setting ¢

A Home

System

Bluetooth & devices

Network & internet

Personalization
Apps
S Accounts
Time & language
@ Gaming
Accessibility
Privacy & security

Windows Update

Accounts > Other Users

Other users

B Microsoft

Create account

someone@example.com

v

2. Install Blender for the created user: We will install blender locally in the users home

directory. We must check that we are following the Systems requirements.

We will download Blender 4.2 from the Blender download page. In particular, we take the

4.2 LTS for Windows.

We will download the Windows - Portable (.zip) version:

https://www.blender.org/download/release/Blender4.2/blender-4.2.8-windows-x64.zip

Unzip the file in the user home directory. In our case it is C:
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|\Users\falke\Documents\blender-4.2.8-windows-x64 (the user falken10vdl has as home
directory C:\Userslfalke).

Congratulations! You have now Blender installed locally in your machine. You can launch it
by double clicking in blender.exe which is situated in the previous folder.

Now install the Bonsai Blender extension. Follow the Unstable installation.

Congratulations! You have now the Bonsai Blender extension installed in your local
Blender installation.

3. Install VSCode: Log in as the new created user (falken10vdlin this example) and install
Visual Studio Code.

4. Adjust Python version in VSCode as in Blender: This is a good practice step to ensure
that the Python version in VSCode matches the one in Blender.

Check the Python version in Blender by going to |Scripting|. In the Python Console you can
see the version number of the Python interpreter

(Unsaved) - Blender 4.2.7 LTS

Renderin

Select Add Object v X lates [@v + New g Open

In our case it is version 3.11.7

We will need to install the closest version in our Linux machine.

We check in either in Microsoft store or Python Downloads.

The closest version is 3.11 in Microsoft Store. So we installing by clicking in .

After this, we have the 3.11 python version installed in our machine. It is reachable by
typing python3.11 in the terminal.

python3.11 -V
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Command Prompt

C:\Users\falke>python3.11 --version
Python 3.11.9

C:\Users\falke>

Launch VSCode and go to the Extensions tab, search for Blender Development and install

Get Started with VS Code

Set Up Copilot for Free

BlendPyBridge
Baasis
DCCWebsocket

gE  Dark Green Jungle theme

DarkPlus Moon light

shades of midnight blue dark theme

This will also install some Python related extensions.

Finally create a sample python file and check the Python interpreter version in the bottom

left corner. Select the Python interpreter that matches the one in Blender. In our case it is
3.11.

File » New File... » Python File

@ EXPLORER

“ NO FOLDER OPENED -+ Create Virtual Environment.

Select Interpreter

B3 Enter interpreter path
You have not yet opened a folder
{23 Use Python from "python.defaultinterpreterPath’ setting
Open Folder Python 3.13.2 64-bit C:\Python313\python.exe Recommended
Python 3.11.9 64-bit (Microsoft Store)
Opening a folder will close all currently operi euitors. 10 keep
them open, instead

You can clone a repository locally.
Clone Repository
You can open a remote repository or pull request without cloning
Open Remote Repository

To learn more about how to use Git and source control in VS Code
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> OUTLINE
> TIMELINE

Congratulations! You have now a Python version in VSCode similar to the one run by
Blender.

5. Connect VSCode to Blender by means of VSCode’s extension: “Blender Development”:
This steps is crucial to be able to develop and debug scripts in VSCode ans interactivwely

see the results in Blender.

Launch VSCode and go to the Extensions tab, search for Blender Development and install

Get Started with VS Code

This will also install some Python related extensions.

Finally create a sample python file and check the Python interpreter version in the bottom

left corner.

[File - New File... > Python File]

Select Interpreter

v NO FOLDER OPENED -+ Create Virtual Environment.

B3 Enter interpreter path
You have not yet opened a folder

£ Use Python from ‘python.defaultinterpreterPath’ setting
Open Folder Python 3.13.2 64-bit C:\P; 313\ 3 Recommended
Python 3.11.9 64-bit (Microsoft Store) M A
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them open, instead
You can clone a repository locally.
Clone Repository
You can open a remote repository or pull request without cloning
Open Remote Repository

To learn more about how to use Git and source control in VS Code

> OUTLINE

> TIMELINE
Xl ®0A0

6. Test that you can develop python scripts in VSCode for Belnder: Create a sample
blender python file under adirectory for example C:
|\Users\falke\Documents\bonsaiDevellscripts. You can use whatever blender python script
you want. We will use this one from the blender documentation:

Example Panel

import

class HelloWorldPanel( . . ):
"""Creates a Panel in the Object properties window"""
= "Hello World Panel"
= "OBJECT_PT_hello"
= 'PROPERTIES'
= 'WINDOW'

= "object"

def draw(self,
= self.

0
="Hello world!", ="WORLD_DATA")

Q)

="Active object is: " +

Q)

, "name"

O

("mesh.primitive cube add")

def register():
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def unregister():

bpy.utils.unregister_class(HelloWorldPanel)

if __name__ == "_main__":
print("Hello World: run from Blender Text Editor")
else:
print("Hello World: run from VSCode")
print(f"NOTE. _ name__ is : {_ name__ }")

register()

We have changed the last part of the script since running from VSCode has some subtle
diferences compared to running from the Blender Text Editor. In particular the special
variable __name__ is different.

Press CTRL-SHIFT-P and type “Blender: Open Scripts Folder”. Select the previous folder
where the script file is located

Press CTRL-SHIFT-P and type “Blender: Start”. Blender will start.

Press CTRL-SHIFT-P and type “Blender: Run Script”. The script will run and the output
will be seen in Blender!

As you can see below. We have set a break-point in line 37 (see point 13 below for
another example of setting a break-point). We can inspect in the left side the local
variables, global variables, add watches, check the stack, etc. For example we can see that
__name__ has a value of “<run_path>" Instead of “__main__".

RUN AND DEBUC D BonsaiDocsServer (IfcOpenShell) v £

bl_label =

bl_idname
bl_space_type
bl_region_type =
bl_context = "object

draw(self, context):
layout = self.layout

obj = context.object

row = layout.row()
row.label(text="Hello world!", icon='WORLD_DATA

r ayout. row()

el (text="Active object is + obj.name)
r ayout.row()
row.prop(obj, "name")

row = layout.row()
row.operator(“mesh. primitive_cube_add"

register():
bpy.utils.register_class(HelloWorldPane

unregister():

bpy.utils.unregister_class(HellohorldPane

print("Hello World
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print(f"NOTE

register()

> CALL STACK
“ BREAKPOINTS

Once we continue execution we can check in the VSCode Terminal the output and in
Blender the panel created by the script.

oA P rer
140

CONGRATULATIONS! You have now a development environment ready to speedup your
python scripting in Blender.

6.X BONUS: Editing Bonsai Documentation: Please refer to Writing documentation for
deatils on ow to edit and contribute
documentation. Here we just summarize the steps to integrate that workflow in
VSCode and using Inkscape.

e Donwload and install Inkscape from Inkscape download page. In our case we will
use Inkscape 1.4 Windows 64 bit msi installer Inkscape download page.

e The file above has the style annotation for the Bonsai documentation. You can use it
to create your own diagrams.
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- - - - - -
EEEEEE B . CEEEEE EEEEE .

e Open some screenshot file you want to add annotations in Inkscape and at also open
this template. You can then copy paste from the temaplate to the screenshot file.

Warning

When copying the shapes for your convenience just make sure that you do not have selected the option
“When scaling objects, scale the stroke width by the same proportion” to keep the style width right.

. New document 1 - Inkscape

File Edit View Layer Object Path Text Filters Extensions Help

me proportion

Document Page Selection Custom

Image Size

e Once done you can export your edited screenshot as PNG to be used in the

docummentation. [File - Export...] and click in the Export button on bottom right

corner.

e As described in Writing documentation you need to have sphinx installed in your
system. One of the easiest ways is to use Chocolately. Then you can simply run the
following command in the terminal:

choco install sphinx

and then install the theme and theme dependencies:

python3.11 -m pip install furo
python3.11 -m pip install sphinx-autoapi
python3.11 -m pip install sphinx-copybutton

All these can be accomplished within a terminal of VSCode.

PROBLEMS OUTPUT DEBUG CONSOLE TERMINAL PORTS COMMENTS

PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell> python3.11 -m pip install furo
Collecting furo
Using cached furo-2024.8.6-py3-none-any.whl.metadata
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e To speedup your workflow you can add the following VSCode files in the .vscode
folder of your cloned repository. In our case itis C:
|\Users\falke\Documents\bonsaiDevelllfcOpenShell\.vscode

e Make sure to edit them before with the right paths in your system.

o launch.json

=] launch.json

File Edit View

{
// Use IntelliSense to learn about possible attributes.
// Hover to view descriptions of existing attributes.
// For more information, visit: https://go.microsoft.com/fwlink/?1inkid=830387
"version": "@.2.0",
"configurations”: [

{

"name": "BonsaiDocsServer",

lke/Documents/bonsaiDevel/IfcOpenShell/src/bonsai/docs/_build/html",
tp.server”],
"Build and Serve Docs",
"console": "integratedTerminal”

Ln1, Col1 635 characters 00% Windows (CRLF)

o tasks.json

tasks.json X +
3

File Edit View
// for the documentation about the tasks.json format

“version": "2.0.0",
"tasks": [

“Build and Serve Docs",
1155
: "powershell”,

"_NoProfile",
“-ExecutionPolicy”,
“Bypass",
"'-Command"

d C:/Users/falke/Documents/bonsaiDevel/IfcOpenShell/src/bonsai/docs/;| .\\make html; cd _build/html; python -m http.server”
1,
“group": {
"kind": "build",
“isDefault": true

1,
“problemMatcher”: []

e Now you can use th debug tool in VSCode to regenerate the html documentation by
cliking the “Play” button BonsaiDocsServer (lfcOpenShell) in the top left corner of
the debug tool.

RUN AND DEBLC ‘®Bonsa\DocSSewey (IifcOpens v &
“ VARIABLES
: Crea

Now let's find out how to interact with GitHub in order to make changes to

6.X N E : Please refer to

documentation. Here we just summarize the steps to integrate that workfl

- Donwload and install Inkscape from

container blockbutton
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- The file above has the style annotation for the Bonsai documentation

:: images/inkscape-annotation-template.png
h: 1000 px

- Open some screenshot file you want to add annotations in Inkscape and

e Once the server is started you can open a browser and go to the following URL:

http://localhost:8000/ and you will see the documentation.

¢ In order to rebuild the documentation you need to stop the server and run the
command again. You can do this by clicking in the “Abort” button in the bottom right
corner of the debug tool.

CONGRATULATIONS! And happy documenting!

Now let’s find out how to interact with GitHub in order to make changes to the Bonsai
project.

7. Install GitHub related VSCode extensions: To facilitate the use of git commands and
pulling and pushing files from a local repository towards github, please install as well the
following VSCode extensions:

o GitHub Pull Requests
o GitHub Repositories

o Remote Repositories

Optionaly you can also install Copilot extensions

o GitHub Copilot
o GitHub Copilot Chat

N File Edit Selection View Go Terminal
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v INSTALLED

Blender Development

.‘.’)1’\.‘][.(":, LUCKe

C/C++

& Microsoft

GitHgb Copilot

&G rvH.m

GitHub Copilot Chat
b GitHub

GitHub Pull Requests

Ol.n tHub

GitHub Repositories

n @ 0 @

a GitHub

Pylance

& Microao:
Python

Python Debugger

Remote Repositories

o ¢ ¢ T

£ Microsoft

8. Fork IfcOpenShell project from GitHub: For this step you will need an account on GitHub.
Once you have a registered account you can find it under https://github.com/
YOURGITHUBUSERID In the example for falken10vd! the link is https://github.com/
falken10vdl

= O falken10vdl Q Type (/] to searct

[ overview [J Repositories 1 [ Projects @ Packages Yr Stars 1

You unlocked new Achievements with private contributions! Show them off by including private contributions in your Profile
in
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Popular repositories
Spoon-Knife Public
Forked from octocat/Spoon-Knife
This repo is for demonstration purposes only

@ HTML

falken10vdl 25 contributions in the last year Contribution settings ~

Go to the IfcOpenShell GitHub page. And click on the Fork button. Please make sure that
you are logged with your GitHub account as shown in the top right corner of the page.

« > C O B8 https://github.com/IfcOpenShell/IfcOpenShel ® 0 O v ® =

= o IfcOpenShell IfcOpenShell QT t S - - Ollnlea .
-

<> Code (©) Issues 959 I) Pullrequests 32 () Discussions ») Actions [ Projects 2 0 wiki @ Security |~ Insights

== IfCOPenShe” ") Sponsor 57 EditPins ~ ® watch 91 ~ % Fork 766 Q vy Star 2k

Existing forks X

¥ v0.8.0 ~ ¥ 74 Bra Q ) You don't have any forks of this repository.

ary and geometry

@aothms oply sk \fra lof 4 ) 17,500 Commits engine
.github dat ) rs ag a
5
aws/lambda
choco/bonsai aib 1S age =)
cmake
conda
docs
nix
Releases 1,877

did
pyodide bonsai-0.8.2-alpha2503201130 ...

Once the fork is generated you will be redirected to your own fork of the IfcOpenShell
project.

« - C QO B https://github.com/falken10vdl/IfcOpenShel
L —

OI falken10vdl / IfcOpenshell

<> Code I Pullrequests () Actions [ Projects [0 Wiki @ Security [~ Insights 3 Settings

@ Ifcopenshell $» Pin  ®Watch 0 ~ v ¥ star 0
forked from
¥ v0.8.0 ~ i B h © 0Tag Q G + <> Code ~ About

Open source IFC library and geometry
i i y ( ) i i v o - A
This branch is up to date with I v . i1 Contribute & Sync fork engine

0 aothms Apply skew in infra lof 1c28442 - 2 ) 17,500 Commits

B github
B aws/lambda

B choco/bonsai

Now we will clone the forked repository to our local machine.

9. Clone bonsai to our development environment: Launch VSCode Select the Source

Control tool. Then [Clone repository| and then select “Clone from GitHub”.
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Provide epository URL o pickarepository

@ clone from GitHub

Visual Studio Code

Editing evolved

Start Walkthroughs

@ Github Copilot e Welcome to Copilot

8 Browse & Edit Remote R

Recent with Python Development [Néi
You have no recent folders, open a

@ Get Started with C++ Development [NéW

A series of steps will be required to authenticate with GitHub. You will need to provide
your GitHub credentials. Once VSCode has authenticated yourself in GitHub, you will be

able to select the repository you want to clone. In this case we will clone the IfcOpenShell
repository.

) FEile Edit Selection View Go Run Terminal Help
SOURCE CONTROL ) Welcome x @ falken10vdl/IfcOpenShell

Open source IFC library and geometry engine

In order to use Git features, you can open a folder co one ® falkenTOvd/Spoon-Knife hetpsi/ait
from a URL. T
Open Folder

Clone Repository

Visual Studio Code
Editing evolved

VSCode will ask you to select a folder where the repository will be cloned. and it will start
the cloning process.

Once finished, you will see the repository in the Explorer tool.

Visual Studio Code
Editing evolved

Start Walkthroughs

*
et Started

Recent

10. Link the Bonsai addon to the local cloned repository: We will now edit the following
script that establishes links from the unstable-installation to the cloned repository so we
can easily see the changes done in the cloned repository taken effect when we load
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blender locally.

Download dev_environment.bat

Edit the file to match the paths in your system. In our case we will edit the following lines:

o SET REPO_PATH=%HOMEDRIVE%\Users\%USERNAME%
\Documents\bonsaiDevel\lfcOpenShell

o SET BLENDER_PATH=%HOMEDRIVE%\Users\%USERNAME%
\AppData\Roaming\Blender Foundation\Blender\4.2

o SET PACKAGE_PATH=%BLENDER_PATH%\extensions\.local\lib\python3.11\site-
packages

o SET BONSAI_PATH=%BLENDER_PATH%
\extensions\raw_githubusercontent_com\bonsai

You need to run it as an administrator. We execute the script in the terminal. Confirm the
data and the script will create the necessary links.

.\dev_environment.bat

[+ Administrator: Command Prompt

Users\falke\Documents\bonsaiDevel>.\dev_environment.bat
SETUP BONSAT ADD-ON LIVE DEVELOPMENT ENVIRONMENT
Update REPO_PATH, BLENDER_PATH, PACKAGE_PATH, BONSAI_PATH in the
This script needs to be run as administrator (to create
Make sure you have followed these steps before proceeding

Currently set patl

if the following is righ
Falke\Documents\bonsaiDevel
\IfcOpenshell Users\falke\Documents\bonsaiDevel \IfcOpenshell
:\Users\falke\AppData\Roaming\Blender Foundation\Blender\.2
\extensions\.local\lib\python3.11\site-packages): C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages
ensions\raw_githubusercontent_com\bonsai): C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4 ensions\raw_githubusercontent_com\bonsai

any key to continue .
Changing to the Git repository directory...
already exists in .gitignore
over compiled IfcOpenshell files.
\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcopenshell\ifcopenshell_wrapper.p
:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4 ensions\.local\lib\python3.11\site-packages\ifcopenshell\_ifcopenshell_wrapper.cp311-win_amde4.pyd
2 file(s) copied.
extension and link to Git
C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\d.2\extensions\.local\Lib\python3.11\site-packages\ifcopenshell\_ifcopenshell wrapper. ET win_amdé4.pyd - Access is denied
mbolic link created for falke\AppData\Roaming\Blender Foundation\Blender\a.2\extension! thubusercontent_com\bonsai\_init__.py << falke\Documents \bonsaiDevel\IfcOpenshell\src\bonsai\bon
sai\__init__.py
symbolic link created for Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\bonsai << falke\Documents\bonsaiDevel\IfcOpenShell\src\bonsai\bonsa
i
Cannot create a file when that file already exists.
symbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifccsv.py << Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifccsv\if
ccsv.py
mbolic link created for s\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extension: ib\py’ 11\site-packages\ifcdiff.py < >> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcdiff\
ifcdiff.py
mbolic link created for falke\AppData\Roaming\Blender Foundation\Blender\.2\extensions\.local\lib\python3.11\site-packages\bsdd.py C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\bsdd\bsdd.p

mbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\bcf <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\bcf\bcf
symbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcdd <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcdd\ifcad
symbolic link created for sers\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcsd < > C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcsd\ifcsd
symbolic link created for C: falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifccityjson <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifccity
json\ifccityjson
ymbolic link created for s\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extension ib\py 11\site-packages\ifcclash <<===>> ers\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcclas
fcclash
mbolic link created for \falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcpatch s\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcpatch\i
fcpatch
mbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifctester < rs\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifctester
mbolic link created for C:\ \falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcfm < > sers\falke\Documents\bonsaiDevel \IfcOpenshell\src\ifcfm\ifcfm
Manually downloading some third party dependencies...
% Total % Received % Xferd Average Speed Time Time Current
Dload Upload Total Left Speed
100 228k 160 228k © o - - - 2685k
% Total % % Xferd Average Speed Time  Time Time Current
Dload Upload Spent  Left Speed
160 18913 166 18913 -] e 524k o - - - 543k
% Total % Received % Xferd Average Speed Time Time Current
Dload Upload Total Spent Left Speed
° e o e o o o 0 —-i--:i--
Warning: Failed to open ths file C: U:ﬂr>\fal¥emppData\Roamlng\Elsndsr‘ Foundation\Blender\4.2\e ions\.local\lib\python3.11\site-packages\bonsai\bim\schema\Brick.ttl: No such file or directory
© 1726k e e e e () -]
curl: (23) client rem«nea ERROR on write of 4134 byt
Press any key to continue .

\Users\falke\Documents\bonsaiDevel>

Warning

If you receive errors like this:

The system cannot find the path specified.
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It means that you have not installed the Bonsai Blender extension. Please refer to tha last part of point 2.

above and follow the Unstable installation.

11. Adjust the VSCode Blender extension: We will now make some adjustments to the
VSCode Blender extension to ease the reload of the addon. Select the Extensions tool.

Then [Blender Developmentj and then select .

£ linu ® = Settings X

13 B=i}

@ext:JacquesLucke.blender-development 13 Settings Found

INSTALLED

Blender Development

o al arguments used

. GitHub Copilot
® i

& GitHub

User Workspace Backup and Sync Settings

Blender: Additional Arguments

r>Addon: Build Task Nai

GitHub Copilot Chat <
] wer ' \t should be
% GitHub =
I sior
GitHub Pull Requests S Uninsta
e Pr i
@  GitHub

GitHub Repositories

addon can be loaded into Blender

r>Addon: Extensions Repository

& GitHub

Pylance R pply Extension to al iles r> Addon: Just My Code

ue, debug only the code in this addon. Otherwise, allow stepping into external python library code.

man!
& Microsoft

Click twice in “Add Item” within the Blender: Additonal Arguments section and add the
following two items (adapt Testing.ifc to the name of the IFC file you want to test during

Bonsai development):

o —python-expr
o import bpy; bpy.ops.bim.load_project(filepath="C:\\Users\\falke\\Documents\
\bonsaiDevel\\Testing.ifc”, should_start_fresh_session=True, use_detailed_tooltip=True)

<= Settings

X

@ext:JacquesLucke.blender-development

User Workspace Folder v

13 Settings Found ==

Backup and Sync Settings

v Extensions (13)

&% | Blender: Additional Arguments
Blender (13)

Additional arguments used for Blender start-up. List of strings.
--python-expr
import bpy; bpy.ops.bim.load_project(filepath="C:\\Users\\falke\\Documents\\bonsaiDevel\\Testing.ifc", should_start_fresh_session=True, use_detailed_tooltip=Trugf X

Add Item

Warning

Note the double backslash in the path for correct interpretation by VSCode
Make sure that Blender > Addon: Just My code is not selected (This allows to set the

breakpoints anywhere in the source code).

evelopment 13 Settings Found

INSTALLED

Backup and Sync Settings
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Blender > Addon: Just My Code

) only the code

C/C++ pytt

£ Microsoft

BJD GitHub Copilot
' & GitHL

Blender > Addon: Load Directory

Warning

This way to use the VSCode Blender extension is not the standard one. Refer to the VSCode Blender
extension documentation for the standard way to use it. The reasond behind is that this allows us to start
VSCode in the top of the cloned repository so all the Git related funtionality in VSCode works properly and
we have a complete view from VSCode tool of the whole repository.

Bonsai is a big project with a lot of dependencies so reloading it it is not an easy task (see discussion in
https://community.osarch.org/discussion/1650/vscode-and-jacquesluckes-blender-vscode/p1). We have
taken the pragmatic approach to start blender with a specific file (7esting.ifc) and then we can reload the
addon from the Blender Ul which also upload automatically the changes in the addon and the testing file To
summarize:

o We need Blender > Addon: Just My code to get the breakpoint functionality even if the addon is not
“registered/loaded” to the extension (due to the root folder we use)

o We need Blender: Additonal Arguments to automatically load the Testing.ifc file when we start Blender
from VSCode (We do not use Blender:Reload Addons since it does not work in our case)

Instead of restarting Blender from VSCode, we use the Blender Ul that, as explainedin the next step, it
provides a simple way to get the addon and the Testing file reloaded.

12. Launch blender from VSCode: We are now ready to launch Blender from VSCode. Open
VSCode. Open the cloned repository if not already open. Press CTRL-SHIFT-P and type
“Blender: Start”.

BODBEO0 - O X
=]

Walkthroughs

Recent

OUTLINE

TIMELINE

Blender will start loading the Testing.ifc file. You can now start exploring the code and
make changes to the addon!
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In order to be able to restart blender (and reload the addons + reload teh Testing file) we

need to enable “Developer Extras” and also a good practice is to enable “Python Tooltips”

in |Edit » Preferences » Interface|.

Interface
Viewport
Lights
Editing

Animation
Get Extensions

Add-ons

Themes

Input
Navigation

Keymap

System
Save & Load
File Paths

Experimental

Blender Preferences

v Display

Resolution Scale
Line Width

Tooltips

Search

v Editors

Color Picker Type
Header Position

Factor Display Type

> Temporary Editors
> Status Bar

v Language

Language

1.00
Default

« Splash Screen

« Developer Extras

+ User Tooltips
+ Python Tooltips

« Sort by Most Recent

+ Region Overlap
« Navigation Controls
Circle (HSV)

Keep Existing

Factor

English (English)

Once these are enabled, you can press F3 and write restart to restart Blender.

2D File
v @ P

& Scene Collection

Edit Render Window Help

& Collection on
v & IfcProject/Projekt-FZK-H @ © @
v IfcBuildingStorey/Erdg

Y& X

(Unsaved) - Blender 4.2.8 LTS

W) ObjectMode v View Select Add Object 7 Global v (Pv §@ Mix v (=

o

User Perspective

%3 (1) IfcBuildingStorey/Erdgeschoss

BIM &5~ Scene fin] @+ ViewLayer [
v @ @ ©@OO - & IFCObject Mode v
Options

SoOCymITUD ST

@B Project Overview

&5 Scene
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otation/Unn ) + Project Info
notation/Unn
Testing.if 4
notation/Unn ﬂ CEEhe ’
inotation/Unn {3 IFC Schema IFC4
notation/Unn A% IFC MVD , Quantity...ew]Option
e 1, Saved 2016-12-2117:54
notation/Unn
notation/Unn
notation/Unn > Git
notation/Unn
+ Spatial
IfcAnnotation/Unn
notation/Unn 7 Sl
cBeam/Unterzug & Default: Erdgeschoss
IfcBuildingStorey/i

IfcDoor/Haustuer el
or/Innentuer
‘cDoor/Innentuer ] Projekt-FZK-Haus
IfcDoor/Innentuer v ) Gelaende
IfcDoor/Terrassen v A FZK-Haus
v = ACID.
Flur
Buero
Bad
allStandardC: Schia
IfcWallStandardC: Wohn
IfcWallStandardCi @ Kiiche
IfcWallStandardC: Restart Blender Y
IfcWallStandardC: Restore Key Maniel o
IfcWallStandardC: Clear All Rest _ Blender will be immediately restarted, save your data first before running this operator.  gnts
cWallStandardC: —
indow/EG-Fe1 Disable Editing Resource Time
cWindow/EG-Fei Edit Representation Item Style
indow/EG-Fe1 Enable Editing Resource Time - T
Reference Structure
Reload Drawing Styles + Project Setup

Remove Drawm'g Style > Project Library

\ - . /‘ > Links
> buildingSMART Data Dictionary
& IfcBuildingSto > Classifications.
> W IfcAnnotation/Unn > Libraries
nnotation/Unn
> Constraints

> Documents.

> Property Set Templates

iildingStorey/I + Geometry
lember/Sparre
> Units
lember/Sparre
IfcMember/Sparre > Georeferencing

lember/Sparre > Geometric Representation Contexts
IfcMember/Sparre  GrEoBE S
IfcMember/Sparre

> Stakeholders

\ Grouping and Filtering
TfcMember/Sparre S
TfcMember/Sparre
per/Sparte 0 Saved Searches
lember/Sparre + Add Search Group
lember/Sparre :

+ Filter Selection

lember/Sparre
lember/Sparre
lember/Sparre
> Colour By Property
lember/Sparre
TfcMember/Sparre > Select Similar
IfcMember/Sparre > Groups
IfcMember/Sparre

TfcMember/Sparre
TfcMember/Sparre

lember/Sparre
lember/Sparre
lember/Sparre
lember/Sparre
lember/Sparre

13. Add a break-point: Let's add a break-point in the code to see how it works. Press
CTRL_SHIFT_P and type “Blender: Start”. Blender will start. Open the cloned folder and

go to src > bonsai > bonsai > bim > module > ligth > prop.py and go to line 75. Add a line

for a print statemente and click on the left side of the line number to add a break-point.

74  def update_shadow_mode(self,
75 print("Shadow mode", self
76 if self "SHADING" :

Set a break-point in line 75.

*(Unsaved) - Blender 4.27 LTS

biect T Global v v [ wix v (8
0
[Tt —m——
update

pdate
update.

update
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Ut Tine: 11
YeDiuplaySu.  Su. 5000
NoShad. @Shaced € Ronc

R Vewkomsu

) projen-rzx

In Blender. Go To SOLAR ANALYSIS Tool in Bonsai and Click in “No Shadow”, “Shaded” or
“Rendered”

Edit Render Window Help &5~ Scene o W viewLayer [O

W, ObjectMode v View Select Add Object 13 Global v Pv e - @- @ &S Scene

e d Options v
won OOy =T
: okt G © User Perspective
B 1rcsuidingsic @ © @ (1) IfcBuildingStorey/Erdgeschoss ® Services and Systems
IfcAnnotas © @
IfcAnnotat ©
IfcAnnotal @
fcAnnotat @ @ v Zones
fAmnoa  © @ i= 0Zones Found
fcAnnot °oQ
fcAnnot: © v Solar Analysis
fcAnnota fod o] o

Annotat @ :
Coordinat 49°06'01.56"N 08°26'11.5.
© ad

v Services

> Systems

Sites: Gelaende - 49.1,8.437 v

C © QA Latitude 49.10 Longitude  8.44
IfcAnnot © True North
IfcBeam/. ©

IfcBuilding © ) - - -
) anuan ate
Ifcboor’H © @ 3 / g
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- Hour 12 Minute

Europe/Berlin
&5 Scene

Local Time: 12:00:00  Sunrise: 08:20:43
G BOOCAM I LD T UTC Time:11:00:00  Sunset: 16:39:18

@B Project Overview v 7 Y% DisplaySunPath  SunPath.. 50.00

« Grouping and Fitering i < I NoShadows @ Shaded ) Rendered I

v Search . Q View From Sun

0 Saved Searches : . v Lighting

+ Add Search Group > Radiance Exporter

v Filter Selection

> Colour By Property

> Select Similar

D No Configurations prop.;

LALLUNY|SELT, LUIILEXL):
VARIABLES

Locals

update hourminute(self, context):
update sun path( )

update date(self, context):
update sun path( )

update_true north(self, context):
update sun path( )

update sun path size(self, context):
update sun path( )

update shadow mode(self, context):
print("Sh: ; .shadow mode)
.shadow_mode == 4
update_sun_path(
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14.

e.v t w_transform =
tool.Blende space()
space.shading. type
.shadow_mo = "RENDE S
f context.scene.sun pos properties.sun_object :
bpy.ops. t.light add(ty, SUN", radius=1, align="WO0
bpy.ops. move to collection(collection index=0)

context. .sun_pos_properties.sun _object = bpy.context.a
update sun path( )
context.scene.render.engine = "BLENDEF
conte is ing.light
rantavt crana dicn inn chau

34

WATCH Process context filter :: 0.00
Calculate model 11 0.00

CALLSTACK

ead_function

Add project to scene

Setting default cont

Import fin in 0.6¢

Warning: File written by newer Blender binary (403.34), expect loss of data!

From here you can watch the local variables, global variables, add watches, check the

stack, etc. Resume execution or move step by step to see how the code is executed.

CONGRATULATIONS! You have now a development environment ready to explore the

Bonsai code and contribute to the project.

Make changes and do a Pull Request to the project: In the previous steps we got a

complete IDE to explore and make changes to the Bonsai sourcecode. In this step we will

provide a simple workflow of using Git commands within VSCode to make changes and

do a Pull Request to the project. Bonsai changes very fast so our cloned repository will be

outdated very soon. We propose to do the following:

a.

D

> Q

Check in our GitHub page if our project fork (https://github.com/falken10vdl/
IfcOpenShell) is outdated compared to the IfcOpenShell main branch (https://
github.com/IfcOpenShell/IfcOpenShell).

. Sync our fork with the upstream branch (if needed).

. Pull the changes in our porject fork to our local repository (/home/falken10vdl/

bonsaiDevel).

. Create a new branch in our local repository (example: DOC_QS_IDE)
. Publish the branch to our project fork in GitHub.

. Make changes in the code.

. Commit the changes.

. Push the changes to our project fork.

. Create a Pull Request to the upstream main branch of the IfcOpenShell project.
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Letis see below the steps with an example of changing the documentation of the
Quickstart guide for the IDE in Linux.

a. Check in our GitHub page if our project fork is outdated. Click Update branch

€ > C

= o falken10vdl

(> Code I

IfcOpensShell

Pull requests ) Actions

@ I1fcopenshell

forked from

¥ v0.8.0 ~ F1

3 Projects [0 Wiki

© £ itpsilgithub comffatientovlifcOpenshell

) Security Insights Settings

® Watch

<> Code ~

This branch is

1>

il Contribute ~ O Syncfork ~

aws/lambda
choco/bonsai
cmake

conda

docs
nix

pyodide

QO 8 http

O falken10vdl

<> Code

IfcOpenShell

} Pull requests Actions

@ Ifcopenshell

forked from

3 Projects

o This branch is out-of-date

Compare

0 «~

About

Open source IFC library and geometry
engine

Update branch

github.com/falker

00 wiki Security Insights Settings

57 Pin ® Watch 0

<> Code ~

i1 Contribute ~

) File Edit Selection View Go Run Terminal Help

SOURCE CONTROL
> CHANGES
 GRAPH £ IfcOpenshell § Aut

Apply skew in infra lofts #6386

ISSUE #6328 fix in dispatch_token to avoid

Retrieve length unit info from underlying mapping in iterator
ifcsverchok - ifc.write_file_panel to filter .ifc files
node.sv_ifc_create_file_refresh - fix LB Out bl_label
ifcsverchok - remove debug print

node.sv_ifc_tooltip - hide title

typing

Read settings from argparser

G Syncfork ~

IfcOpenShell

prop.py M = Settings X

@ext:JacquesLucke.blender-development

User Workspace

Blender: Additional Arguments
Additional arguments used for Blender start-up. List of strings.

python-expr

Packages

- w7 Star 0

About

Open source IFC library and geometry
engine

13Settings Found ==

Backup and Sync Settings

import bpy; bpy.ops.bim.load_project(filepath="/home/falken10vd|/bonsaiDevel/Testing.ifc", should_start_fresh_session=True, use_detailed_too

Add Item

d. Create a new branch in our local repository by clicking in the current branch name in the
bottom left corner of the VSCode window. Give a name to the branch and press Enter.

) File Edit Selection View Go Run Terminal Help
SOURCE CONTROL
> CHANGES
~ GRAPH [ Ifcopenshell §° Auto @ ¥
O Fix Blender 4.4 errors starting some operators... (&}
i’o The experimental cutting tool now supports a bisect mode fo..
2 Minor fix to clipping planes if there is no camera
See #6404, See #1227. Create axis context if it does not exist
Fix #6404. See #1227. Fix IFC2X3 wall creation with new wall .

Some form of circle handling in loop_to_function_item_upgr.

DOC_QGS_IDE

+ Create new branch...

+ Create new branch from...
& Checkout detached

User Workspace

v Extensions (

Blender: Additional Arguments
Blender (13

Additional arguments used for Blender start-up. List of strings.

python-expr

BOoEO -
a8 -

o X

13 Settings Found =% Y

Backup and Sync Settings
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N import bpy; bpy.ops.bim.load_project(filepath="/home/falken10vdl/bonsaiDevel/Testing.ifc", should_start_fresh_session=True, use_detailed_tool
ISSUE #6328 fix in dispatch_token to avoid missing unknown
Retrieve length unit info from underlying mapping in iterator Add Item
ifcsverchok - ifc.write_file_panel to filter .ifc files Andrej
node.sv_ifc_create_file_refresh - fix LB Out bl_label A )
Blender > Addon: Build Task Name
ifcsverchok - remove debug print An
Task that should be executed before the addon can be loaded into Blender
node.sv_ifc_tooltip - hide title
typing A 3
Read settings from argparser
pyodide demo: install shapely T Blender > Addon: Extensions Repository
Update publish-pyodide-demo-app.yml Th
o 5 L Blender extensions only: repository to use when developing addon
Update wheels #6402 Blender -> Preferences -> Get Extensions -> Repositories (dropdown, top right)
Blender 4.4 - fix broken Ul lists #6396... Ar
vscode_development
Implement readable setting type retrieval 15 Krijn
Reinstate old bespoke model-offset/rotation parsing in IfcCo.
Normalize model-rotation quaternion Thomas K Blender > Addon: Just My Code
Bonsai makefile - fill last_commit_date f true, debug only the code in this addon. Otherwise, allow stepping into external python library code.
Fix missing default value for *last_commit_date" (37ec2bf) #
Use explicit *bLui_utils.layout" import to fix #6389..

debugging docs - add section about debugging addon Blender> Addon: Load Directory

e e S i) Directory that contains the addon that should be loaded into Blender
See #1227. Fix bug where unjoin walls didn't recheck the posi i
Fix #6318. Fix warnings when decorator cannot convert 3D to,
Quantification to consider Pset_ProfileMechanical.MassPerLe..
Blender > Addon: Module Name
quantification fallback - small clarification
Name or the symlink that is created in Blenders addon folder
typing And
black . er
Issue #5130 fix + sheet all expand and contract (#6379)
Fix #6372. See #1227. More reliable layer slicing. Always slice ..
See #1227. Clear cache when activating drawings. Dion Moult
get_shape_aspects to consider element's type #6374... A

Fix Ul errors in case of uppercase unit names (7af6727).

The new branch is created and we can see it in the bottom left corner of the VSCode
window.

expan
Fix #6372. See #1227. More reliable layer slicing. Always slice ...
See #1227. Clear cache when activating drawings.

get_shape_aspects to consider element's type #6374...

L (Git) - Publish Branch 's€ unit names (7af6727)...

IfcOpenShe

T ' T - U | . -1 . R FiYaiaTala)!

¥ DOC_QS_IDE* &

e. Publish the branch to our project fork in GitHub by clicking in the publish button (little
cloud with up arrow) in the bottom left corner of the VSCode window. Select as origin
the project fork.

) File Edit Selection View Go Run Terminal Help 8 BO0E@O - O X

SOURCE CONTROL oo origin https://github.com/falken10udifcOpenshellgit 08

> CHANGES upstream w enShell/IfcOpenSh
v GRAPH £ IfcOpenShell §° Auto 3 D ~+ Add a new remote... 13 Settings Found =

Fix Blender 4.4 errors starting some op... (SIBOCIGSHDD &

User Workspace Backup and Sync Settings
The experimental cutting tool now supports a bisect mode fo.

Minor fix to clipping planes if there is no camera © Eo——

See #6404. See #1227. Create axis context if it does not exist Blender Blender: Additional Arguments
Fix #6404. See #1227. Fix IFC2X3 wall creation with new wall Additional arguments used for Blender start-up. List of strings.
Some form of circle handling in loop_to_function_item_upgr... R ——

Apply skew in infra lofts #6386 Thor r
import bpy; bpy.ops.bim.load_project(filepath="/home/falken10vdl/bonsaiDevel/Testing.ifc", should_start_fresh_session=True, use_detailed_tool|

ISSUE #6328 fix in dispatch_token to avoid missing unknown ..
Retrieve length unit info from underlying mapping in iterator Add Item
ifcsverchok - ifc.write_file_panel to filter .ifc files Andrej

node.sv_ifc_create_file_refresh - fix LB Out bl_label
Blender > Addon: Build Task Name
ifcsverchok - remove debug print An
Task that should be executed before the addon can be loaded into Blender
node.sv_ifc_tooltip - hide title And
typing
Read settings from argparser

pyodide demo: install shapely Blender > Addon: Extensions Repository

Update publish-pyodide-demo-app.yml
(Bt & L2 Blender extensions only: repository to use when developing addon.
Update wheels #6402 a Blender -> Preferences -> Get Extensions -> Repositories (dropdown, top right)
Blender 4.4 - fix broken Ul lists #6396.
vscode_development
Implement readable setting type retrieval Thomas Krijn
Reinstate old bespoke model-offset/rotation parsing in IfcCo...
Normalize model-rotation quaternion Th j Blender > Addon: Just My Code
Bonsai makefile - fill last_commit_date f true, debug only the code in this addon. Otherwise, allow stepping into external python library code.
Fix missing default value for *last_commit_date" (37ec2bf) #..
Use explicit *blLui_utils.layout” import to fix #6389
debugging docs - add section about debugging addon A e oo D ecton
T R e e RAEIE: Directory that contains the addon that should be loaded into Blende
See #1227. Fix bug where unjoin walls didn't recheck the posi —
Fix #6318. Fix warnings when decorator cannot convert 3D to..
Quantification to consider Pset_ProfileMechanical.MassPerLe
Blender > Addon: Module Name
quantification fallback - small clarification

Name or the symlink that is created in Blenders addon folder
typing A

black ouTPuT ) - ter
Issue #5130 fix + sheet all expand and contract (#6379)

Fix #6372. See #1227. More reliable layer slicing. Always slice

See #1227. Clear cache when activating drawings. Dion Moult

get_shape_aspects to consider element's type #6374... And
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Check that the branch is now in our project fork in GitHub.

B Ofalken10vdlllfc0pen5hel X +
« > C O B https://github.com/falken10vdl/IfcOpenShell

# AlmaLinux {* Documentation {*Blog ‘% Bug tracker % GitHub organization

= O falken10vdl / IfcOpenShell Q Type [/]to search

<> Code {7 Pullrequests (» Actions [ Projects [0 Wiki @ Security |~ Insights 3 Settings

@ Ifcopenshell ru 2 Pin | ® wateh

forked from

+ v0.8.0 ~ ¥ 2 Brar S Add file ~ <> Code ~ About

Switch branches/tags Open source IFC library and geometry

19 Contribute ~ & Syncfork ~ engine

Q_ Find or create a branc
17,506 Commits

Branches = Tags

v v0.8.0 default Update publish-pyodide-demo-app.yn

DOC_QS_IDE

View all branches
cmake
conda
docs
nix

pyodide

migrate docs urls

bonsaibim urls

Don't allow a for add_commit_sha

bonsaibim

doc clude doxyg submodule

Update build-all.py; --force when fetch tags

wasm wheel fixes

watching

0 forks

Releases

s published

Packages

Languages
fy variant stc

win Fetch boost from github releases in build scripts 2 months agc ® C++762% Python 20.1%
C2.6% Gherkin 0.4%
.clang-format clang-format: remove duplicates from base style ® Javascript 0.2% @ SWIG 0.1%

® Other 0.4%

.
.
.
]
.
| src
]
.
B
B

.clang-tidy clang-tidy: add basic checks

f. Make changes in the code. In this case we will change documentation by adding a
Quickstart for the IDE in Windows. :)

Qoo

+ UNTITLED (WORKSPACE) > bonsai > docs > quikstart > ide > windows.iders
¥ HfcOpenshel

a 1 s . In the previous steps we got a complete IDE to explore and make changes to the Bonsai sourcecode.
Create a new branch in our local repository by clicking in the current branch name in the bottom left corner of the VSCode window. Give a name to the branch and press Enter.
age:: images/new-branch-local.png
Adth: 1000 px

e. Publish the branch to our project fork in GitHub by clicking in the publish button (*Little cloud with up arrow?) in the bottom
left corner of the VSCode window. Select as origin the project fork

:: inages/new-branch-publish-to-private-github.png
dth: 1000 px

Check that

github.png
idth: 1000 px

£. Make changes in the code. In this case we will change documentation by adding a Quickstart for the IDE in Windows. :

ge:: inages/make-changes.png
dth: 1000 px

name and email to Git

images/git-user-email.png
h: 1088 px

Then commit the changes by clicking in the check mark in the Source Control tool

images/commit-changes.png.
h: 1000 0

g. Commit the changes.

First provide your user name and email to Git.

TERMINAL MMEN ]

PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell>|git config user.email
PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell>|git config user.name
PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell> T]|
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Then commit the changes by clicking in the check mark in the Source Control tool.

J File Edit Selection View Go Run Terminal Help

SOURCE CONTROL

v CHANGES

Add quickstart for Windows 1D

@ v/ Commit
v Changes

Accept the staging of the changes prior to commit.

Visual Studio Code

There are no staged changes to commit.

Would you like to stage all your changes and commit them directly?

Never Always Cancel Yes

h. Push the changes to our new branch in the github project fork.

e Edit View Go Run Terminal Help IfcOpenShell

SOURCE CONTROL s = index.rst X

\/ CHANGES . src > bonsai > docs > = index.rst

> IfcOpenShell ¢  poc 304 1r o 118Y builder html and (not singlehtml)
r toc-cards

> input
Inpul global-index-toc

> mvd
> svfill
v Sample-BIM-Files
Quickstart
2

quickstart/introduction to bim
cityjson o L (O oo quickstart/installation
quickstart/explore model

Check that the changes are in the project fork in GitHub. You can see that the directory
ide has been added, for example.

= O falken10vdl IfcOpenShell Q t 5 F Ol .

<> Code I Pullrequests () Actions [ Projects [ wiki Security |2 Insights 3 Settings
[] Files J quickstart / (5 Add file ~

7 DOCQS._.. (e . falken10vd| i t f Nind A 1) History

This branch is

1) Contribute ~ & Sync fork ~

N ETT

| ide

nix .
M images

pyodide

rTEFEEERERTE

[ create_model.rst
src
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v [ bonsai [ installation.rst

> B bonsai \ - i i
[ introduction_to_bim.rst
> [ build

[ next_steps.rst

i. Create a Pull Request to the upstream main branch of the [fcOpenShell project. Go to
your GitHub page and you will see that the new branch has 1 commit ahead of the
upstream main branch. Click in the Compare & pull request button.

« > C QO 8 https://github.com/falken10vdl/IfcOpenShell/tree/DOC

= o falken10vd| IfcOpenshell

(> Code 1 Pullrequests () Actions [ Projects [ Wiki ) Security ~ Insights S Settings

@ I1fcopenshell

57 Pin ®Watch 0 ~
forked from

¥ DOC_QS_IDE had recent pushes 36 minutes ago Compare & pull request About

Open source IFC library and geometry

engine
¥ DOCQS_IDE ~ | > f t o <> Code ~

This branch is 1% Contribute ~ O Syncfork ~

. falken10vdl O 17,507 Commits

Verify that the changes are correct, add a description and click in the Create pull
request button.

« > C O B https://github.com/IfcOpenShell/IfcOpenShell/comy

0...falken10vdL:IfcOpenShe
— O IfcOpenShell IfcOpenShell

<> Code (©) Issues 962 {1 Pullrequests 32 () Discussions ») Actions [ Projects 2 0 wiki Security |~ Insights

Comparing changes

1 base repository: IfcOpenShell/IfcOpenShell ¥ base:v0.80~ € head repository: falken10vdl/IfcOpenShell ¥ compare: DOC_QS_IDE ¥

Able to merge. The

. Add a title

Helpful resources
Add quickstart

Add a description

Write Pre H B

This is documentation with all the steps required to implement a simple yet powerful IDE workflow to work with Bonsai
Sourcecode

I Markdown is supported (A Paste, drop, or click to add files

¥ Allow edits by maintainers l Create pull request - I

CONGRATULATIONS! You have now made a change in the Bonsai project and created a
Pull Request to the main branch of the project. Happy coding and documenting!
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